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In This Version 
The main purpose of the Service Desk 5.10 release is to provide a migration path from Service Desk 4.5 to 
Service Desk 5.10. However, the migration tools will be delivered separately. This release is intended to 
provide an environment to migrate to. 

This release contains improvements that have been implemented since Service Desk 5.0, including the 
following: 

• Web console. 

• The ability to log approval votes in history lines. 

• List of approvers maintained during an object’s life. 

• Blocking of services, service levels, and service level agreements. 

• Additional custom fields. 

• Email templates for outgoing notification emails for approvals and assignments (for service calls, 
incidents, problems, projects, changes, and work orders). 

• Enhanced metric data collection. 

• The ability to configure Service Level Manager (SLM) dimension exports from the HP OpenView console. 

• Enhanced metric heartbeat management (metric states are displayed as available, unavailable, or 
unreachable in the HP OpenView console). 

• The command line utility for the HP OpenView console, ovconsolecmd, has been enhanced to accept 
filter parameters from the command line. This is useful for integrating other programs with the HP 
OpenView console. You can now, for example, open a view from the command line that displays all calls 
originating from a particular phone number. 

• Console administrators can now create relationship types, and console users can specify those types 
when they create relationships between objects. This is useful when objects can have multiple kinds of 
relationships with each other. For example, a Configuration Item can be related to an Incident in the 
following ways: Emitting CI, Root Cause CI, Emitting Node, or Impacted Node. 

• Hierarchical grouping of forms, views, and actions. Lists of existing forms, views, and actions are now 
grouped by object type in the HP OpenView configuration workspaces. This enables you to find the form, 
view, or action that you want much more quickly. It also enables you to update certain attribute values 
for multiple forms, views, or actions at the same time.  

• Customizable system views for enhanced audit logging. You can now choose the system view used to 
display enhanced audit logging information.  

• Reusable classifications and closure codes groups. You can now create reusable classifications and 
closure code groups that are persisted in the HP OpenView database. This enables you to define m-to-n 
relationships between objects. This is useful for restricting the values a console user can choose from for 
a particular field on a form. You can accomplish this by using the “Limit field value range by relations” 
action in a UI rule. 

• Ability to create new objects by using templates with missing required fields. It is now possible to use a 
template that does not contain values for all required fields as a nested template. When the template is 
used to populate a form's values, and such a nested template is used, the console user is prompted to 
provide the missing required field values. 

• Ability to audit configuration settings. If you log on to the console by using an account with the Auditor 
role, you can audit changes – including additions, modifications, or deletions – that take place in the HP 
OpenView Configuration workspace. 
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• Ability to select certain email attachments for database rules. This feature enables you to send certain 
attachments to certain email recipient groups when a database rule that specifies the “Send e-mail 
message” action is triggered. 

• Configuration Exchange improvements. The following improvements were made to the Configuration 
Exchange function: selectively blocking or unblocking objects, including copy fields and audit rules, 
enhanced log file readability, improved run-time messaging, and including the references audit (list of 
blocked or deleted objects that are still referenced by other objects). 

• Secure FTP option for attachments. A configuration option in the Administrator Console now enables 
you to send and receive attachments by using Secure FTP (FTPS). 

• Option to apply view filter in Advanced Find. If you enable this option in the General Settings dialog 
box, when console users launch the Advanced Find function, the filter operating on the current view (if 
any) is also applied to their search results. They can also select a different view to display the search 
results. 

• Condition field prepopulated in Advanced Find. If you open the Advanced Find dialog box by pressing F2 
from a look-up field, the summary of filter criteria field is prepopulated based on the value of that 
attribute. 

• Central control of automatic refresh interval. The HP OpenView console administrator can now exercise 
central control over the interval at which the console clients refresh the active view with information 
from the database. If you do not select this option, console users whose role permits them to do so can set 
their own refresh intervals. 

• “Older Than” and “Newer Than” conditions available in Advanced Find. You can now search for objects 
based on the values of certain date and time related attributes. You can specify all objects older than or 
newer than a specified number of days. 

• Smart action fields can now contain CR/LF characters. You can now embed carriage-return and line-feed 
characters in a smart action field. This enables you to specify more than one command in a smart action. 

• UI rules can now be triggered by up/down arrows on a form. When you click the up or down arrow 
buttons on a form, the selection in the current view moves up or down accordingly, and the form for the 
selected object is opened. You can now trigger a UI rule when the selection changes as a result of clicking 
up or down. 

• New Rules log files track Rule Manager debugging messages: INFO, WARN, SEVERE, and FINE. (The 
system log file continues to hold Rule manager non-debug messages.) 

• Automatic three retries if a Data Update or data Exchange action fails. 

• Emails initiated by Database rules can include attachments, and can specify a group (category) of 
attachments. 

• Emails initiated by Database rules can now go to multiple addresses, and each address is separated by a 
semi-colon (;). 

• New action choice available: Limit field range by relations. 

• The following triggers can now be launched by agents on other systems (such as a Web API or an email 
interface) and can launch a database event that can potentially trigger another event: 

⎯ When a value has changed 

⎯ After an item has been opened 

⎯ After new item has been opened 

⎯ After existing item has been opened 

⎯ Before the item is saved 
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• The following actions are now executed in the background: 

⎯ Update Data 

⎯ Limit field value range 

⎯ User Notification message 

⎯ Data exchange with external system 

⎯ Command Exec Action (executed on the server, not the client machine) 

NOTE: Rules can trigger other Rules. As you add Rules, make sure you do not create loops, which 
can lead to problems with system stability and data integrity. History lines have an additional 64KB 
attribute field named New Value, so more of the history information is visible. 

• Object relationship management enhancements: 

⎯ Relate arbitrary objects. For example, create a UI rule action that, when triggered, restricts the 
available values a user can choose for a field. Or limit the range of relations between a particular 
entity and the set of all possible values. 

⎯ Auditing of relationships between objects now allows auditing of many-to-many relations.  

For information about the differences between HP OpenView Service Desk 4.5 and HP OpenView Service 
Desk 5.0, refer to HP OpenView Service Desk 5.0 Differences Between 4.5 and 5.0/5.1. 

The new HP OpenView Service Desk Support Guide contains information about tracing, logging, and 
troubleshooting. 

For information about the versions of the integrated products Service Desk can integrate with, refer to the 
Supported Platforms list at this URL: http://openview.hp.com/ecare/getsupportdoc?docid=OV-EN020917.  

For information about the integration with HP OpenView Operations, refer to the HP OpenView Service 
Desk OpenView Operations Integration Administrator’s Guide. For information about the other 
integrations, refer to the HP OpenView Service Desk Data Exchange Administrator’s Guide. These 
guides are delivered in the integration release of which they form a part; they are not delivered in Service 
Desk 5.10. 
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Documentation Updates 
The first page of this document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates, or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name.  

2 In the Version list, click the version number.  

3 In the OS list, click the OS type.  

4 In the document list, click the document title.  

5 To retrieve the document, click Open or Download.  

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following URL:  

http://www.adobe.com

Installation Notes 
Installation requirements, and instructions for installing Service Desk, are documented in HP OpenView 
Service Desk 5.1 Installation Guide, provided in Adobe Acrobat (.pdf) format.

Note the following potential problem regarding HP-UX. 

A Problem Arises When the Software DVD-Rom Is Mounted on HP-UX 

Problem 

A problem arises when the software DVD-Rom is mounted on HP-UX. 

Workaround 

To mount the DVD-Rom on an HP-UX system, use the following commands: 

nohup pfs_mountd& 

nohup pfsd& 

pfs_mount -o soft <DVD-Rom ID> /cdrom 

DVD-Rom ID is the ID of your actual DVD-Rom. 

You can find this ID by using the following command: 

ioscan -funC disk 
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Installation Problems 

This section provides workarounds to known installation problems. 

 
Installation Problems on Solaris 9 and 10 
Problem 

On Solaris, a “Finalize action warning” error is displayed at the end of the installation. The application 
installer tries to start all the processes and the ovobs process fails.  

The error message states the following: 

Finalize action for HP OpenView Service Desk Management  

Server (Starting the server.) was not successful. 

The following shows the status after the installation: 

Ovcd        OV Control                CORE         (2434)   Running 

ovbbccb     OV Communication Broker   CORE         (2435)   Running 

ovloginsv   OV Login Server           JAVA                  Stopped 

ovapacheA   OV Apache(A) WebServer Service   WEB            Aborted 

ovsdma      OV SLM OVSD Metric Adapter SLM         (2757)   Running 

ovtomcatA   OV Tomcat(A) Servlet Container   WEB   (2625)   Running 

ovsdslm     OV Service Level Management SLM        (2762)   Running 

ovobs       OV Object Server            OBS                 Aborted 

ovcs        OV Certificate Server       SERVER     (2763)   Running 

ovsdreport  OV Service Desk Reporting   SDREPORT            Aborted 

This problem is linked to the value of the timeout of the OV Control process, which is too small for Solaris 
systems.  

Workaround: 

Enter the following commands: 

1 ovc –kill 

2 ovconfchg -ns ctrl.ovcd -set ACTION_TIMEOUT 120 

3 ovc -start 

QXCR1000315787: 
Apache Startup 
Problem 

For all UNIX systems in a NIS-controlled environment, the OvApacheA package, installed during the 
Service Desk Management Server installation, does not create the user ovwebusr and the group 
ovwebgrp. To solve this, manually create the user ovwebusr and the group ovwebgrp on the Network 
Information Service (NIS) server after installing the OvApacheA product and before starting the OvApacheA 
WebServer service. 
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Workaround 

1 Add a group:  

groupadd ovwebgrp 

2 Add the ovwebusr group: 

 useradd -G ovwebgrp ovwebusr 

3 Restart the Apache process: 

ovc -start ovapacheA 

Installation Freezes 
Problem 

If the installation screen remains static for a very long time, your machine may have frozen. 

Workaround 

To prevent the installation from freezing, follow these steps: 

1 Download scripten.exe from the Microsoft web site: 

www.microsoft.com.

2 Run the scripten.exe file. 

3 Restart your computer. 

4 Run the setup.exe file again. 

Error Messages in the Log Files 
Problem 

You encounter error messages in the following log file: 

C:\Program Files\HP OpenView\data\log\system0.0.en_US

Example: 

Oct 18, 2005 9:01:48 AM;5;10;com.hp.ov.obs;SEVERE;SQL Exception: JDBC error 942: ORA-00942: 
table or view does not exist, SQL state: 42000 for query: select 1 from 
itsm_personsjava.sql.SQLException: ORA-00942: table or view does not exist 

Workaround 

None. Do not be alarmed. These messages do not impact the behavior of the application. 

QXCR1000320074: 
JVM Memory Consumption 
Problem 

When using Service Desk 5.10, you might see some unusual traces in the log file, as shown in the following 
example: 

Feb 28, 2006 10:31:49 AM;142;18;com.hp.ov.obs;SEVERE;JVM uses  

518,979,584/518,979,584= 100% of maximum memory (total/max) of which  

322,468,824/518,979,584= 62% is free (free/total). 

Feb 28, 2006 10:33:49 AM;143;18;com.hp.ov.obs;SEVERE;JVM uses  

518,979,584/518,979,584= 100% of maximum memory (total/max) of which  

296,562,824/518,979,584= 57% is free (free/total). 
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Workaround 

Change the maximum memory used by the Object Server process: 

1 Edit the file called OvObs.xml. 

Location on Windows: C:\Program Files\HP OpenView\data\conf\obs 

Location on UNIX: /var/opt/OV/conf/obs  

2 Change -Xmx512m  to -Xmx1024m, and save the changes. 

3 Unregister Object Server by using the following command: ovcreg -del ovobs 

4 Register Object Server again by using the following command:  

Windows: ovcreg -add C:\Program Files\HP OpenView\data\conf\obs\OvObs.xml 

UNIX: ovcreg –add /var/opt/OV/conf/obs/OvObs.xml 

5 Start Object Server by using the following command: ovc -start 

Enhancements and Fixes 
This section describes any major new features and the fixes for defects raised by customers in this release. 

Enhancements 

Self-Healing Services 
Self-Healing Services software is shipped with this release. It is included when you install the Service Desk 
Management Server software.  

To access the Self-Healing Services Software, open an internet browser and browse to the following location: 

https://localhost:8443/SAM

Use the default username and password combination: admin/admin 

Self-Healing Services software can be used to gather and submit data necessary to streamline the resolution 
of problems found in Service Desk 5.10. HP recommends the use of Self-Healing Services, and it is included 
in every support contract. Documentation and downloads are available at 
http://support.openview.hp.com/self_healing.jsp. 

The automatic submission of troubleshooting data to GP Support requires the installation of the HP Instant 
Support Enterprise Edition software (ISEE). You can acquire this software from the following location: 
http://support.openview.hp.com/self_healing_downloads.jsp

To enable or disable Self-Healing Services software: 

• To disable the Support Automation Manager (SAM) web application, enter the following command:  

• Windows: cscript %OVINSTALLDIR%/bin/shsctrl.vbs –disablesam  

• UNIX: /opt/OV/bin/shsctrl –disablesam  

• To enable the SAM web application, enter the following command.  

• Windows: cscript %OVINSTALLDIR%/bin/shsctrl.vbs –enablesam  

• UNIX: /opt/OV/bin/shsctrl –enablesam  
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The disable option unregisters the SAM web application and the enable option registers it. 

If the ovtomcatA service is running when you disable or enable the SAM web application by using the above 
commands, you will need to restart the ovtomcatA service for the changes to take effect. 

Fixes 

This release includes all the customer fixes included in patches since Service Desk 5.0. 
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Known Problems, Limitations, and Workarounds 
This section describes known problems, limitations, and related workarounds for Service Desk. 

General Problems 

This section describes how to work around general problems you may encounter with Service Desk. 

Starting the Management Server on UNIX platforms: QXCR1000350463, QXCR1000312290, 
and QXCR1000350190 
Problem 

Because of a defect in the GUI Framework component, table views and chart views are not displayed 
properly on a management server running on UNIX platforms. 

If you try to open a view, this error message is displayed: 

Cannot open this view. This is probably due to a persistence problem with the view. Check 
Object Server log file(s) for more information. 

Workaround 

To overcome this problem, the following workaround must be implemented on the UNIX machine. 

When the management server is started, an X Server must be running and used by the ovc process. This can 
be achieved in different ways, and one method is described as follows: 

1 Log in to the management server by using telnet or another tool. 

2 If it is not stopped, run the following command to stop the Management Server software: 

# /opt/OV/bin/ovc –kill 

3 Start a dummy X server, which is part of most UNIX distributions, including HP-UX and Sun Solaris. 

On HP-UX, enter the following command: 

#nohup /usr/bin/X11/Xvfb :9 \ 

0</dev/null \ 

1>/dev/null \ 

2>/dev/null \ 

& 

On Sun Solaris, enter the following command: 

#nohup /usr/openwin/bin/Xvfb :9 \ 

0</dev/null \ 

1>/dev/null \ 

2>/dev/null \ 

& 

These commands start the dummy X server on display #9. For more information about this X server, 
refer to http://en.wikipedia.org/wiki/Xvfb or read the man pages.  

Because this server has started, you can start the management server again, but first you have to set the 
DISPLAY environment variable to point to this X server. To do this, enter the following commands: 

# DISPLAY=:9 
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# export DISPLAY 

# /opt/OV/bin/ovc –start 

 

The views will now be displayed properly. 

When you want to implement this workaround when the server is rebooted, you have to edit the script that 
starts ovc, which you can find in the following location:  

HP-UX  

/sbin/init.d/OVCtrl 

Sun Solaris 

/etc/init.d/OVCtrl 

NOTE: You might need to clean the client’s cache to reload the views from the server. To do this, clean out 
the folders $HOME/.ov on UNIX and %APPDATA%\HP OpenView on Windows. 

Incorrect Messages in the Log Files during Installation 
Problem 

In the system0.0.en_US log file, the following message appears twice consecutively: 

"com.hp.ov.obs.security;SEVERE;441No Passwords in License File error code: 5997" 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Problem 

During the installation of Service Desk 5.10 on Solaris, in the system0.0.en_US log file, the following 
message appears: 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdma.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvsdMA.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvSdSlm.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdslm.xml'. 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Log-on Exceptions 
Problem 

After you install Service Desk, you encounter a log-on exception.  

Workaround 

Before using the Secure Socket Layer logon, execute the OvObsClientSettingsEditor.bat file. 

Failure to execute this file results in the following error message: 

Javax.security.auth.LoginException: Failed to login due to RpcException: unexpected HTTP 

status: 503 Service Unavailable. 

For information on the user authentication mechanisms available, including the use of the Lightweight 
Directory Access Protocol (LDAP) and Active Directory, refer to the Service Desk online help (in the 
Contents tab of the Help Navigator window, see the section Information for Administrators>Users & 
Security, and see the topics in the sections on User  Authentication, Principal Mappings, and 
Accounts).   
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QXCR1000329577: 
Self-Healing Registry Key Remains after Service Pack 1 is Installed 
Problem 

A registry key remains after Service Desk is uninstalled. 

Workaround 

Manually remove the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\SH Services\Supportability Adapter\dc 

The value is SDESK. 

QXCR1000289191: 
Help Only Available When Using the Default Port 
Problem 

The online help is not available when Apache is installed on a non-default port. Because the application 
installer offers you the option to set another port for Apache, this problem could affect you. 

Workaround 

None. 

QXCR1000244984: 
Incidents Generated by the Alarm Engine are Not Correctly Filled 
Problem 

For all incidents created by the alarm engine, the associated service level is not correct. It is always the 
same service level for all the incidents. 

Workaround 

You can modify the configuration item (CI) linked to the incident. Because the incident is created 
automatically for the specific CI, the user should not be able to modify the CI. 

Expected behavior: 

• Service level must be set with the right service level name. 

• User cannot modify the value of the incident’s CI field. 

QXCR1000283641: 
Searching for Text from “Localized Text” Does Not Work 
Problem 

By default, it is not possible to search for text in Localized Text or its subfolders.  

Note: If you select one of the subfolders of Localized Text, and run Advanced Find, this subfolder becomes 
available to the search engine, and is added as a searchable folder in Advanced Find, added to the bottom of 
the list. These changes are lost again after restarting the console. 

To reproduce the problem: 

1 Click OV Configuration→Presentation→Localized Text, and select the Localized Text folder. 

2 Open the Advanced Find form by pressing F2 or clicking Advanced Find in the menu bar. 

3 Search for localized text in Localized Text and in one of its subfolders. 
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Expected Results 

The Advanced Find form opens. The Show field contains Localized Text, and you can select one of its 
subfolders (for example, Label Text). You can run a search in Localized Text and in one of its subfolders. 

Actual Results 

Pressing F2 does not open the Advanced Find form. Clicking the Advanced Find button in the menu bar 
opens Advanced Find, but Localized Text and its subfolders are not available to the search. They cannot be 
selected in the Show field. 

Workaround 

None. 

QXCR1000289979: 
No Data is Presented on a Java Web Start Client after an Object Server Failover 
Problem 

No data is presented on a Java Web Start client after an Object Server failover. 

Prerequisites: 

Two management servers installed refer to one database. 

To reproduce the problem, follow these steps: 

1 Start two Java Web Start clients on two different machines, referring to different management servers. 

2 Stop one of the management servers. 

Expected Results 

After the failover, the Java Web Start client that referred to the stopped management server is connected 
automatically to the running management server. All data is still accessible.  

Actual Results 

After the failover, the Java Web Start client that referred to the stopped management server is connected 
automatically to the running management server. Data is not accessible anymore. Data creation is no longer 
possible. 

Solution 

Download the Java Web Start client again by using the URL connecting the second application server. 

Service Pages Installation Hangs If Apache and Tomcat are Already Running 
Problem 

When trying to install Service Pages, the installer hangs and does nothing. 

Prerequisites 

A system for Service Pages, with the Apache web server and Tomcat Servlet container already running. 

To reproduce the problem, attempt to install the Service Pages installer. 

Expected Results 

The installer runs, and the installer splash screen appears.  

Actual Results 

Nothing happens. The installer interface does not appear. 

Workaround 

Stop Apache and Tomcat before running the installer. 
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QXCR1000294601: 
Service Level Created from Java Web Start is Not Visible on OvConsole 
Problem 

The service levels created on the Java Web Start console are not visible from OvConsole. 

To reproduce the problem, follow these steps: 

1 Start Java Web Start. 

2 Create one service level. 

3 Start the HP OpenView console. 

4 Open the list of the service levels. 

You cannot see the service level created with the Java Web Start console.  

Workaround 

It is recommended that you reconnect to see other entities. The problem may be fixed after service levels are 
not cached any more. If a client updates a cached entity, other connected clients do not automatically update 
their cache. This design decision was made for performance reasons. Cached entities should be fairly static. 
At the time, the functional impact was considered to be low. 

QXCR1000242246: 
{I18N} Apache Service is Not Registered in the OS When Installed in a Non-ASCII Path 
Problem 

When a Service Desk installation includes an Apache server (such as the Service Desk 5.10 Server 
installation), and is installed in a path that contains non-ASCII characters (for example Chinese, Japanese, 
or Russian), the Apache server is not installed properly.  

As a result, all functionality that relies on the Apache server does not work: 

• Java Web Start client 

• Web UI 

• Service Pages 

• Attachments 

• Online help 

Workaround 

None. 

QXCR1000244548: 
Traces Using Java Web Start 
Problem 

When a client is deployed using Java Web Start, some logs are not recorded. 

Some of the graphical user interface log messages are logged in the Object Server log file. 

Workaround 

None. 
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QXCR1000323328: OVO/W-SD and OVO/U-SD Integrations: 
Bbc Service Missing from 'opcagt' after Installing SD 5.0 Client 
Problem 

When the Service Desk 5.10 standalone client is installed on a machine where the OVO Agent is installed, 
running the opcagt -status command no longer displays the BBC Local Location Broker service. Do not 
be alarmed. The omission of this service from the list does not impact the behavior of the OVO Agent. 

Workaround 

None. 

QXCR1000349637: 
Upgrade on Clients Overwrites ovconsole.bat 
Problem 

When you upgrade to Service Desk 5.10, ovconsole.bat is overwritten. Properties, such as Server and 
JAASApplication, will be lost. 

Workaround 

Before you upgrade, make a copy of ovconsole.bat (copy the file to ovconsole.old, for example). After you 
upgrade, refer to the copied file to identify the settings you need, and update ovconsole.bat with those 
settings. 

QXCR1000348152: 
No Assignment Notification Template in Email Settings 
Problem 

After an upgrade from Service Desk 5.0 or Service Pack 1, you will not have any new email templates in the 
application.  

Workaround 

To get these email templates after an upgrade, you can use Configuration Exchange to import the following 
file:  

%OVINSTALLDIR%misc\sd\config\sd_emailtemplates.xml  

Do not select the Overwrite Existing Items checkbox. For information about Configuration Exchange, 
refer to the Service Desk online help. 

QXCR1000344669: 
Error When Relation Type is Changed 
Problem 

An error occurs when you attempt to change the relation type of a relation associated with an object (for 
example, if you edit a relation listed on the Relations tab of a service call form, and change the Relation 
Type on the Service Event Relation form). 

Workaround 

Instead of editing the relation, delete the relation and create it again. 

Service Level Management 

This section describes known problems, limitations, and workarounds related to Service Level Management 
(SLM) in Service Desk. 
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Metric Adapters: Tuning the Query Limitations 
Problem 

The query restriction in the HP OpenView console can be set to display a maximum of 500 metric definitions 
and 1000 metrics. The query restriction is required to use OVPA metrics or any other metrics with big 
volumes. 

Workaround 

To disable the query restriction, follow these steps:  

1. In the OV Configuration workspace, select Presentation. 

2 In the panel, select Search.  

3 Double-click and select No restriction (instead of Restricted to) for each of the following objects:  

⎯ Metric Definition  

⎯ OVxx Metric  

⎯ OVxx Metric Definition  

QXCR1000244984:  
Incidents Generated by the Alarm Engine Are Not Correctly Filled 
Problem 

When an incident is generated by the SLM Alarm Engine, its service level attribute is not related to the 
generation of the incident. 

Instead, the service level determination works as follows: 

• If the related configuration item has a service level, that service level is taken. 

• If not, the default service level is used. 

Workaround 

None. 

QXCR1000316864: 
Severe Errors in Join Tables Operation 
Problem 

Severe errors are logged in the Object Server log file. All the errors are related to a Join Table Operation. 
The severe errors associated with the query builder error on join tables are generated when you try to 
remove a service definition that has an associated service.  

The following traces will be created in the log files: 

Feb 10, 2006 3:24:39 PM;99;11;com.hp.ov.obs;SEVERE;Error 

com.hp.ov.obs.impl.util.DeveloperException: Query Builder can not join tables cdm_services 
[281478426132597] and cdm_services_x [272934308553576458]. 

Check relations between cdm_services on one hand, and cdm_services_x and cdm_services_x on 
the other. in method createReferencedTable 

 at 
com.hp.ov.obs.impl.da.AppQueryBuilder.createReferencedTable(AppQueryBuilder.java:1392) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.makeJoin(AppQueryBuilder.java:2025) 

 at 
com.hp.ov.obs.impl.da.AppQueryBuilder.listWhereParts(AppQueryBuilder.java:2595) 

 at 
com.hp.ov.obs.impl.da.AppQueryBuilder.listWhereParts(AppQueryBuilder.java:2610) 
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 at 
com.hp.ov.obs.impl.da.AppQueryBuilder.createConcreteQuery(AppQueryBuilder.java:335) 

 at 
com.hp.ov.obs.impl.da.AppQueryBuilder.createQueryBuilder(AppQueryBuilder.java:223) 

You can safely ignore these traces because they do not indicate any severe problem with the software. 

Workaround 

None. 

QXCR1000299666: 
SLM Licensing: No Messages Sent to the Client Console 
Problem 

When an SLM licensing problem occurs, no message is sent to the client console, but all licence events are 
logged in the SLM log file. For example, if the number of services authorized by licenses is reached, you can 
create a new service, but the SLA Activity Status remains not managed. 

SLM manages only the number of services licensed. If a greater number of services are ready in the CMDB 
for SLM management, only a licensed number of services are managed. The other services are not managed. 
The non-managed services are listed only in the log file, and the SLM management status may be 
inaccurate. 

Workaround 

None. 

Web Start 

This section describes known problems related to Web Start deployment. 

QXCR1000305148: 
Starting SD 5 Client Deployment using Web Start 
Problem 

If you deploy the Service Desk 5.10 Client from a UNIX to Windows system by Web Start, the names’ 
resolution must be consistent.  

Workaround 

Make sure that you do not have any inconsistency between the full internet name and the alias name. For 
example, if you use http://myhostname.domain.org/ovconsole  (full internet name) as a command for 
downloading the Service Desk 5.10 Client on Windows, the deployment will fail if, on UNIX, the result of 
“hostname” is myhostname (alias name). 

Smart Actions 

This section describes known problems related to Smart Actions. 

QXCR1000309377: 
Smart Action Create Work Order in Service Call Generates Error Message 
Problem 

Open a Service Call form and start the Action Create Work Order. This generates the following error 
message: 

Windows cannot find 'Files/HP'. Make sure you typed the name correctly, and then try again. 
To search for a file, click the Start button, and then click Search. 
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Every time the UI rule condition is met, an error occurs. 

 Workaround 

In the OV Configuration workspace group, click Actions and Rules >Applications. 

Select Service Desk Form and change the command line. The default value of the Command line field is 
call "$PRODUCTFOLDER$\bin\ovconsolecmd.bat". Remove the call command from the command line. 

QXCR1000324443: 
Smart Actions Pass ID Parameters in Wrong Format 
Problem 

Create a smart action that passes an ID as a parameter to an external command.  

Use the external command echo %* on Windows, or echo $* on UNIX. 

Make sure the ID is greater than 1000.  

When the ID is greater than 1000, the GUI shows commas between the thousands (or a period, depending on 
the locale), for readability. The smart action passes the ID as a parameter in the same format, that is, with 
commas. This is wrong. 

An example where this results in errors is when the smart action invokes a script that sends the results 
back to Service Desk by using LoadObject. LoadObject uses the ID to identify the entity to modify. However, 
LoadObject expects an ID without commas. 

Expected Results 

The ID parameter must be passed without formatting, that is, without characters that improve readability. 

External interfaces like smart actions and LoadObject must use the same formatting of parameters. 

Workaround 

The script called by the smart action should remove the formatting of the ID before further processing. 

This workaround is only applicable for smart actions that call a script that can be modified. 

If you call a 3rd party executable, this workaround will not work. 

OVO and MOM Integrations 

This section describes known problems, limitations, and workarounds in the HP OpenView Operations for 
Windows (OVO/W), UNIX (OVO/U), and Microsoft Operations Manager (MOM) integration packages of 
Service Desk. 

QXCR1000323681: OVO/W-SD Integration: 
Integration Account in OvObsLoadObject.conf Cannot Create Incidents  
Problem 

Integration account does not allow OVO/W messages to create incident records in Service Desk. 

Workaround 

Manually modify the OvObsLoadObject.conf file. Move the line with the entry SERVER to the line just 
below [OVOBSLOADOBJECT]. 

The delivered configuration file OvObsLoadObject.conf contains the following lines: 

[OVOBSLOADOBJECT] 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 
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ACCOUNT=OVOW_server1/Password4OpenV!ew 

SERVER=sdmanagementserverhostname 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 

Change the contents of the file to the following: 

[OVOBSLOADOBJECT] 

SERVER=sdmanagementserverhostname 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=OVOW_server1/Password4OpenV!ew 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 

 

QXCR1000323681: MOM-SD Integration: 
Integration Account in OvObsLoadObject.conf Cannot Create Incidents  
Problem 

Integration account does not allow MOM messages to create incident records in Service Desk. 

Workaround 

Manually modify the OvObsLoadObject.conf file. Move the line with the entry SERVER to the line just 
below [OVOBSLOADOBJECT]. 

The delivered configuration file OvObsLoadObject.conf contains the following lines: 

[OVOBSLOADOBJECT] 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=MOM_server1/Password4OpenV!ew 

SERVER=sdmanagementserverhostname 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 

Change the contents of the file to the following: 

[OVOBSLOADOBJECT] 

SERVER=sdmanagementserverhostname 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=MOM_server1/Password4OpenV!ew 

PORT=30980 

MAPPING=ovowindows 
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CLASSNAME=incident 

MODUS=insert 

The line that contains the server tag is now at the top. This ensures that the SERVER tag is interpreted 
correctly. 

QXCR1000314392: OVO/W-SD Integration:  
'Monitor Service Desk Log File Policy' does not Work 
Problem 

This policy does not work. There are two issues.  

1 %OvDataDir% is not the correct syntax. Therefore, this variable is not replaced and the file cannot be 
found.  

2 The policy assumes there is only one Service Desk log file, but there are several. You could use HP 
OpenView Operations’ log file preprocessing to get a list of all the log files and to monitor all the log files. 

Workaround 

1 You should use <$OvDataDir>\log\servicedesklogfile in the policy, where servicedesklogfile is the name 
of a log file. 

2 To monitor multiple log files, create in OVO/W a log file monitoring policy for each log file. 

QXCR1000314396: OVO/W-SD integration: 
'Monitor sd_event Log File Policy' does not Work 
Problem 

This policy does not work. There are three issues:  

1 %OvDataDir% is not the correct syntax. Therefore, this variable is not replaced and the log file cannot be 
found. 

2 Error messages are not logged in the OvObsLoadObject.log log file mentioned in the policy. 

3 The policy uses Read from beginning (always). 

Workaround 

1 To search for server errors, in the “Monitor sd_event Log File” policy, use <$OvDataDir>. 

2 Change the file name <$OvDataDir>\log\OvObsLoadObject.log to 
<$OvDataDir>\log\OvObsLoadObject_error.log. 

To search for server errors, use the following pattern: 

SERVER RESPONSE=<*.ServerError>  

To search for client errors, use the following pattern:  

CLIENT_ERROR=<*.ServerError> 

3 Change the policy by selecting Read from beginning (first time).  
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QXCR1000314387: OVO/W-SD Integration: 
Several Issues with Import of Nodes from OVO/W 
Problem 

OvSdOvowCi2003.conf contains the following default setting: 

PWD=openview 

Workaround 

Change the password setting to PWD=user 

QXCR1000333600: OVO/U-SD Integration: 
Database Rules cannot be Modified Straight after Import 
Problem 

When you modify the database rules uploaded into Service Desk during the configuration of the integration, 
the following error occurs: 

Could not show dialog(com.hp.ov.obs.admin.rules.db.form.DBRuleWizard). 
java.lang.NullPointerException 

Workaround 

Restart the Service Desk server processes with the commands: ovc –stop and ovc -start. 

Usability 

This section describes known usability problems, limitations, and workarounds in Service Desk. 

QXCR1000304079: 
OV Control 
Problem 

ovapacheA and ovobs processes abort after a reboot. 

Workaround 

After rebooting your system, restart the processes manually: 

ovc -start 

QXCR1000296194:  
Compound Schedule Entities 
Problem 

Schedule entities that include Compound Schedule entities are not supported as Service Hours or Planned 
Downtime. Only Schedules that include Schedule elements are supported. Compound Schedule entities 
including Compound Schedule entities are not correctly handled by SLM. 

Workaround 

None. 

QXCR1000303777:  
Service Today 
Problem 

Automatic refresh does not work in the Service Today view. In the default filter pattern, a newly created 
Service Today view does not show any items.  
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Workaround 

Use the Refresh button in the View menu to see the latest calls. 

QXCR1000290261: 
SQL Server Specific Errors: Cannot Create a Row of Size 14072 
Problem 

When you fill completely all the fields in a form when using SQL Server, you might get an error message 
when you try to save the form.  

Workaround 

Remove some information from the form. 

QXCR1000324111: 
In Web Console in Service Call SLA and Location Information are not Retrieved from Adding 
Caller 
Problem 

In the Web Console, in some cases a service and an SLA are not retrieved. The steps below describe the 
situation in which this problem can occur.  

To reproduce the problem, follow these steps: 

1 In the OV Configuration workspace, click System Settings. 

2 Double-click Service and SLA retrieval Settings for Service Call. The Service and SLA retrieval 
Settings for Service Call dialog box appears. 

3 In Automatic Service and SLA retrieval in Service Call, select from Caller, Caller Organization, 
and Service field. 

4 Add all the search criteria in the following order: Caller Organization hierarchy, Locations of 
Organization hierarchy, Caller, and Caller’s location. 

5 Select Stop the search if Services and SLA’s are found for a particular criterion. 

6 Select Enable Search and SLA retrieval from Caller Location field. 

7 Find the service level impact-priority mappings (click Data>Codes>Service Level>Impact Priority 
Configuration). 

8 Create a new default impact-priority mapping named DIPM, so that, for example, a low impact maps to 
a low priority. All impacts must be mapped to priorities. 

9 Click Data>Codes>Service call>Service call priority duration setting. 

10 Set the priority-duration settings from Top to Low priority: 1 hour, 2 hours, 4 hours, 6 hours, 8 hours, 
and so on.  

11 Click System Settings>General settings, and select the Application tab. 

12 Deselect Search Caller Person in Organization tree. 

13 By using the Default Support Hours field, do the following: 

⎯ Create and relate a support hours schedule named SHDefault, with Sunday 00:00 to 08:00 as 
support hours 

⎯ Create a support hours schedule named SHA, with Sunday 12:00 to 00:00 as support hours 

⎯ Create a support hours schedule named SHB, with Saturday 12:00 to 00:00 as support hours. 

14 Add a Service Level workspace to a workspace group. 
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15 Create a new service level named SLDefault, in which you relate the DIPM impact-priority mapping, 
and select Default. 

16 Create a service level named SL1 related to DIPM. 

17 Create a service level named SLB related to DIPM. 

18 Create two persons, and name them Caller1 and Caller2. 

19 Create an organization named Org. 

20 Make Caller1 and Caller2 members of Org. 

21 Create an organization named POrg, and set the child organization to Org. 

22 Create a business location named LoCaller, and relate persons Caller1 and Caller2 to this location (by 
using the Works at field). 

23 Create a business location named LocPOrg, and relate it to POrg (by using Hosted at). 

24 Create a service named SLocCaller, with receiver LocCaller. 

25 Create an SLA named SLALocCaller, relate it to SLocCaller, with receiver LocCaller, and relate 
service level SLB and support hours SHB (by using the Schedules field). 

26 Log in to the Web Console by using the system account. 

27 Create a service call, setting Caller to Caller1. 

Actual Results 

Service is not set. 

SLA is not set. 

Caller Location is not set. 

In the HP OpenView Console, everything works as expected. 

Expected Results 

Service set to SLocCaller, SLA set to SLALocCaller. 

Caller Location set to LocCaller. 

Workaround 

If the caller location is entered in a service call, the service and SLA values are retrieved immediately. 

This error occurs only when the service receiver is a location. If the service receiver is an organization, the 
function works according to expectations.  

Service Pages 

In Service Pages, when you try to save an item that has no changes to be saved, an exception will be thrown. 
You can safely ignore this exception because it does not indicate any error. 

Known Limitations 

This section describes the known limitations of this Service Desk release. 

1 You cannot include a schedule element in a schedule element. If you want to include a schedule element 
B in a schedule element A, you can achieve this by including (or excluding) the schedule elements in 
schedule element B. 
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2 Restriction because of defect QXCR1000306550. Users must set the Actual Start field to 00:00:00 when 
they create or update an SLA to prevent problems in the reporting. There are two problems: the first day 
is not displayed, or incorrect values are displayed (the values displayed are the values from the previous 
evaluation period). 

3 The installer on HP-UX does not use the argument -x mount_all_filesystems=false to install the SD-SLM 
packages. This means that if there are file systems declared in etc/fstab, the installation fails with the 
following error: One or more filesystems that appear in the filesystem table are not mounted and cannot 
be mounted. You must modify the file /etc/fstab to be able to install SLM (remove one or more file 
systems).  

By design, the Software Distributor uses mount_all_filesystems=true as a default value.  Part of 
the reason for this is that filesystems may be mounted in the /opt/OV or /var/opt/OV rooted directory 
structure. Additionally, the /opt/OV or /var/opt/OV directory structure may contain symbolic links 
that reference other mounted file systems. 

4 Restriction because of defect QXCR1000241122. The LoadObject functionality in Service Desk 5.10 
currently uses Perl version 5.6. Unfortunately, Perl 5.6 does not support Unicode, as a result of which all 
Service Desk functionality that uses LoadObject will not be able to handle Unicode dataflow properly. 
This issue impacts all integrations that use LoadObject, such as OVO for Windows and OVO for Unix. 

Product Co-existence 

This section describes known product co-existence problems, limitations, and workarounds. 

Some OpenView products share the same component on a specific system. When you install an OpenView 
product on a system where another OpenView product is already installed, the installer first checks to see if 
the latest version of the shared component is installed. An older version of a component will be replaced by 
the latest version during the install process. Because of this, in some cases the component process scheduled 
for replacement, and other dependent components, will be stopped prior to installation. As a result, you may 
need to restart these stopped component processes after installation. For more information about restarting 
these component processes, refer to the relevant product documentation. 

The following examples illustrate the issue: 

OVO/W 7.21 and 7.5 
Problem 

When you install the Service Desk 5.10 client on a system where HP OpenView Operations for Windows 
(OVO/W) 7.21 or 7.5 Client is already installed, the OVO/W HP ITO Agent Windows Service stops. 

Workaround 

Restart the HP ITO Agent manually. 

OVO/U 7.1 
Problem 

When you install the Service Desk 5.10 client on a system where HP OpenView Operations for UNIX 
(OVO/U) 7.1 HP-UX Client is already installed, the OVO/U llbserver process stops. 

Workaround 

Restart the llbserver process manually. 

24 



OVO/U 8.1 
Problem 

When you install or uninstall the Service Desk 5.10 client, agent or OVO/U integration on a system where 
HP OpenView Operations for UNIX (OVO/U) 8.1 is already installed, the OVO/U ovcd process and the 
OVO/U agent stop.  

Workaround 

Restart the ovcd process and the OVO/U agent manually. 

Problem 

When you install or uninstall the OVO/U agent on a system where the Service Desk 5.10 Management 
Server is installed, the Service Desk processes stop. 

Workaround 

Restart the Service Desk processes manually with the command ovc –start. 

Documentation Errata 
This section describes the following: 

•  Any errors in the published documentation 

•  Latest information that could not be included in the published manuals or online help 

Errors in Online Help 

The following items are listed incorrectly in the documentation and could not be fixed before the software 
release. 

LOCATION: “Enable the detailed List button” online help topic. 

ERROR: Instructions indicate that you should edit the ovconsole [bat, sh] file. This file is 
overwritten when the software is updated or upgraded, so you should not edit it. 

CORRECTION: Do not edit the ovconsole [bat, sh] file. Instead, set the OV_JAVA environment 
variable in the operating system. The executable file that it should point to is java.exe. 
If OV_JAVA points to javaw.exe instead, you will not be able to enable the Detailed List 
button on the memory diagnostic panel. 

New Content Ability to Select Certain Email Attachments for Database Rules 

LOCATION: “Configure a Send Email Message Action” online help topic. 

ERROR: You can now send groups of email attachments by using the Send Email Message action 
in a database rule. 

CORRECTION: Send Email Message Actions 

The Send Email Message action uses the information you provide to send an email 
message to one or more designated recipients. You can include groups of attachments 
that share a specific email classification code. In the following example, all attachments 
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classified Red or Blue are included in the email message: 

 

NOTE: You can add a Send Email Message action only to a database rule. You cannot 
add this action to a UI rule. 

 

Define Attachment Classification Codes 

Attachment classification codes enable you to group attachments. You can subsequently 
include one or more attachment groups in email messages generated by database rules. 

The following example shows a console installation with four attachment classification 
codes defined: 
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You can create, modify, and delete attachment classification codes if your role permits 
you to do so. 
 

To define an Attachment Classification Code:  

1 In the HP OpenView Configuration workspace group, click Data.  

2 In the Data tree, expand the Codes branch. 

3 In the Codes branch, expand General. 

4 In the General branch, click Attachment Classification Code. 

5 If the attachment classification code that you want to work with exists, double-click 
it. 

If you want to create a new attachment classification code, right-click in the right 
panel, and select New Attachment Classification Code. 

6 In the Text box, type a name for your attachment classification code. 

7 If you want to select an Icon for this code, click the  (find icons) button to select 
one. 

8 If you want to select a Color for this code, click the  (choose color) button to 
select one. 

9 In the Ordering box, enter an integer value that places this code in the proper order 
with respect to any other existing attachment classification codes. 

10 Click File→Save and Close to save your changes. 

 

Assign a Classification to an Attachment 

When you attach a file to an object, you can assign an attachment classification to it, as 
shown here: 
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In this example, there are four attachment classification codes defined: Red, Blue, 
Yellow, and Purple. The classification code that will be assigned to the purple.txt 
attachment is Purple. 

Attachment classifications are used to send groups of attachments to one or more email 
recipients when a database rule triggers a Send Email Message action. If you choose not 
to assign a classification code to an attachment, that attachment will belong to the 
Unclassified group; this is the default. 

You can Define Attachment Classification Codes to suit your environment. Although you 
can change the classification of an attachment at any time, you cannot delete the 
classification altogether. To do this, you must delete the attachment and then create it 
again. 

To assign a classification to an attachment: 

1 Open a form for an object. 

If the attachment that you want to classify is already attached to this object, go to 
step 5. 

2 Click the  (attachment) button on the toolbar. 

If the toolbar is not visible, click View→Toolbars, and select Standard. 

3 Browse for the file, and click Open. 
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4 Click the Attachment Details tab. 

5 Right-click the attachment, and select Attachment Classification. 

6 Select a classification code for the attachment. 

7 Click File→Save and Close. 

 

Configure a Send Email Message Action 

Use this action to have a database rule send an email message to one or more recipients. 
You can attach one or more groups of files (attachments) to this email message. 

To configure a Send Email Message Action, complete the following steps: 

1 Open a Send Email Message Action form from the Database rules wizard. 

If you are not in the process of creating a Database Rule, see the help topic titled 
“Creating Database Rules and UI Rules.” 

2 Type a name for the action in the Name field. 

3 Select the Blocked box if you want to disable this action. 

4 In the Send To field, enter one or more addresses to which the email message 
should be sent. Use the Insert Attribute button to enter predefined email 
addresses. 

NOTE: If you specify multiple email addresses, separate them with a semicolon (;) 
 

5 In the Subject field, enter the text you want to appear in the subject line of the 
email. Use the Insert Attribute button to insert predefined pieces of information, 
such as a priority or a deadline for response.  

6 In the Message field, compose the text of the email message you want the action to 
send. You can use the Insert Attribute button to insert predefined pieces of 
information. 

7 Optional: If you want to include one or more groups of attachments in the email 
message, select the groups that you want in the Classifications box. 

If the only classification listed in the box is Unclassified, that means that no 
attachment classifications have yet been defined.  

8 When you have configured the Action, click OK. The new action now displays as an 
available action for the rule.  

 

New Content: Reusable custom codes, UI rule actions that limit value ranges for fields, generic 
association mechanism  

LOCATION: “Limit Field Value Range by Relations Actions” online help topic. 

“Configure a Limit Field Value Range by Relations Action” online help topic. 

ERROR: This content is not included in the Service Desk 5.10 online help. The online help topics 
listed above are incomplete and incorrect. 

CORRECTION: Limit Field Value Range by Relations Actions 

This type of action determines which values for a code type attribute appear in the drop-
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down list representing that attribute on forms. These values are not stated explicitly but 
instead depend on the values of one or more other code type attributes. 

In the following form, for example, the Assignment Priority choices for the Sample 
Incident have not been limited in any way: 

 

All four of the Assignment Priority code values are available in this form. 

In this example, however, the values available for the Assignment Priority code are 
limited to Low and Medium: 
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This constraint of the Assignment Priority code values was the result of a Limit Value 
Range by Relations action that was triggered by a UI rule. 

There are three steps required to successfully invoke this type of action:  

1 Create a relationship between two codes. 

2 Create a value reference mapping that defines how the value of one code should vary 
with the value of the other. 

3 Define a UI rule that enforces the value mapping. To do this, you must configure a 
limit field value range by relations action for this rule. 

Here is a simple example of how this process works. In this example, the values of the 
Assignment Priority code for an Incident are based on the value of the Severity code for 
that Incident. 

Step 1: 

Create a relationship between the Severity code and the Assignment Priority code. 
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Step 2: 
Create one or more value reference mappings to define how the values of the target code 
should vary with value of the input code. 
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Step 3: 

Define a UI rule that invokes an action that enforces the mapping. 
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In this example, the database rule limits the value of the Assignment Priority code for 
an Incident whenever the Severity code for that Incident changes. Here is the result for 
an Incident where Severity is Minor: 
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In addition to built-in codes, you can use custom codes to create a Limit Field Value 
Range by Relations action in a UI rule. See an advanced example for more information 
about using custom codes. 

NOTE A UI rule can trigger a Limit Field Value Range by Relations action in the 
background as a result of another rule. If this happens, subsequent Update Data actions 
linked to other rules can only set a value allowed by the most recent Limit Field Value 
Range by Relations action. 

An Advanced Example  

 
NOTE  The explanations and examples shown here only limit the values of code 

attributes. While it is most common to do this with codes, technically any 
reference attribute can be limited in this fashion.   

This example features a UI rule that uses the Limit Field Value Range by Relations 
action with custom codes. In this example, a hypothetical company has support offices in 
two regions: 

• Asia / Pacific 

• Europe / Americas 

Lower severity Incidents (Severity = Normal, Warning, or Minor) are routed first to the 
Asia / Pacific support office; higher severity Incidents (Severity = Major or Critical) are 
routed to the Europe / Americas office.  

NOTE  This is a highly contrived example designed to highlight the functionality of this 
action. The HP OpenView console offers much simpler ways to route Incidents 
to the proper offices. 

 

A UI rule will be configured to limit the values available for the State field (Incident 
Status code) whenever an Incident is assigned to a new support agent. The rule will use 
a Limit Field Value Range by Relations action that traverses the following chain of 
relationships: 
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In this example, Severity and Incident Status are built-in codes. Support Agent Types 
and Support Regions are custom codes. 

Three Incident State values were added to indicate that an Incident has been assigned to 
a particular support region: 

 

Before the rule is applied, the Incident State choices for the Sample Incident have not 
been limited in any way: 
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Note that this Incident has not been assigned to a Person yet, and all seven of the 
Incident Status code values are available in this form. 

After the UI rule fires, however, the values available for the Incident State code are 
limited depending on the Severity of the Incident. In this case, only one State choice is 
available after the Incident has been assigned to Klara Hausmann: 
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This has nothing to do with Klara Hausmann’s location. The constraint of the values 
available for State results from the Severity of the Incident. 

Here are the steps necessary to create this example: 

Create the custom codes. 

Create forms for each of the custom codes. 

Create the relations in the chain. 

For each of the codes in the chain, create value reference mappings. 

Create a UI rule that triggers when the To Person field changes. 

Create the Limit Value Range by Relations action. 

Each of these steps is shown here with screen captures. 

Step 1: Create the custom codes Support Agent Types and Support Regions, and create 
values for both codes: 
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Step 2: Create a form for each of the new custom codes: 
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Step 3: Create the following relationships: 
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Step 5: Define a UI rule that invokes an action that enforces all the mappings: 
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Step 5: Create a UI rule that triggers when an Incident is assigned to a Person.  

Here is the result for an Incident where Severity is Minor: 
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Here is the result for an Incident where Severity is Major: 

 
 
Use Custom Codes  

In addition to the built-in code type attributes that came with your HP OpenView 
application, you can create custom codes. These are useful when you want to create  
m-to-n relationships between objects that are not otherwise related to each other. The 
primary purpose of such relationships is to construct Limit Field Value Range by 
Relations Actions for UI rules. 

After you create a custom code, you can use it like any other code in the console. You 
must, however, first create a new form for your custom code before you can use it to 
construct an action for a UI rule. 
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To create a custom code: 

1 In the HP OpenView Configuration workspace group, click Data. 

2 In the Data tree, expand the Codes branch. 

3 In the Codes branch, click Custom Codes. 

4 Right-click your mouse in the right panel, and select New custom code (ordered). 

5 In the Name box, type a name for your custom code. 

6 In the Key box, type a short string of characters that has not previously been used 
as a Key for another custom code. 

7 From the Module list, select the module where you want to store your custom code. 

8 Click OK to save your custom code.  

9 In the Presentation workspace of the HP OpenView Configuration workspace group, 
create a new form for your custom code. Be sure to include the Referenced From 
field on your form. 

Create a Relationship Between Two Codes  

Before you can create a Limit Field Value Range by Relations action for a UI rule, you 
must create a relationship between two codes. This is a mechanism you can use to create 
m-to-n relationships between objects. 

To create a relationship between two codes: 

1 In the HP OpenView Configuration workspace group, click Data. 

2 In the Data tree, click Relations. 

3 Right-click your mouse in the right panel, and select New Relation. 

4 In the Text box, type a name for your new relationship. 

5 In the From box, select the code that you want the relationship to originate from.  

6 In the To box, select the code where you want the relationship to terminate. 

7 Optional: In the Comment box, type a descriptive comment. 

8 Click File→Save and Close to save your new relationship. 

 
Create a Value Reference Mapping  
 
Before you can create a Limit Field Value Range by Relations action for a UI rule, you 
must create a mapping from each possible value for one code to one or more values for 
the other code. See Limit Field Value Range by Relations Actions for an example. 
 
To create a value reference mapping: 

1 In the HP OpenView Configuration workspace group, click Data. 

2 In the Data tree, expand the Codes branch. 

3 Double-click the specific code type that terminates the relationship. 

 

For example if you have created a relationship from A to B, double-click B. 
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4 For each code B value that you want to map, follow these steps: 

 
a. In the right pane, double-click a code B value. 
 

A form specific to code B opens. If you created a custom code, this will be the 
form that you created. 

 
b. For each code A value that you want to map to this code B value, 
follow these steps: 
 

i. In the Referenced From field, click New. 
 

The New--- Reference dialog box opens. 
 
ii. In the Relation field, use the quick find function to select the relationship 

that you created for your two codes. 
 
iii. In the From field, use the quick find function to select the code A value 

that you want to map. 
 

The description for the code A value appears in the From Description 
box. This is a read-only field. The description for the code B value that you 
double-clicked in step (a) appears in the To Description box. This is also 
a read-only field. 

 
iv. Click OK to save your changes and close the New--- Reference dialog box. 
 

5 Click File→Save As to save your mappings for this code B value. 

Return to step 4(a) if you want to map additional code B values. After you have mapped 
all the values that you want to map, you can create Limit Field Value Range by 
Relations Actions for UI rules based on this relationship. 

 
Configure a Limit Field Value Range by Relations Action  
 

After you create a relationship between two codes, and you create a value reference 
mapping between them, you can use this relationship to create a Limit Field Value 
Range by Relations action in a UI rule. 

 

For this procedure, assume again that you have created a relationship from code A to 
code B and that you want to use this relationship to limit code B’s values by using a UI 
rule: 
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To configure a Limit Field Value Range by Relations Action, complete the 
following steps: 
 

1 In the UI rules wizard, select the Limit field value range by relations action. 

If you are not in the process of creating a UI Rule, see the online help topic titled, 
“Creating Database Rules and UI Rules.” 

2 In the Name box, type a name for the Action that you are creating. 

3 Optional: Select the Blocked box if you want to disable this Action.  

4 In the Target Field box, select code B, whose values you want to limit. 

5 In the Input Field box, select code A. 

6 In the Relationship Type 1 box, select the relationship you defined between code A 
and code B. 

It is possible to create a chain of up to four relationships between codes. In this case, 
you would select additional Relationship Type fields to traverse this chain. 

7 Click the Add to List button. 

You have just created a pattern that will limit the values for code B based on the 
value of code A when the UI rule trigger condition occurs. You can create a number 
of patterns if you want to. The patterns are tested in the order they are listed until a 
pattern returns a set of values. 

If you want to create more patterns, repeat steps 5-7. 

8 When you have finished configuring the action, click OK. The new action now 
displays as an available action for the UI rule. 

9 Click Next to continue creating the UI rule. 

10 In the Name box, type a name for your new rule. 

11 Optional: Select a Category for the rule. 

12 Optional: Select Block if you want to prevent this rule from firing. 

13 Optional: Select Debug if you want the console to print debug information to the 
rule log file. 

14 Click Finish to save your new UI rule. 

 

New Content: Audit Configuration Information 

LOCATION: “Audit Configuration Information” online help topic. 

ERROR: You can now audit information in the HP OpenView Configuration workspaces. 

CORRECTION: Audit Configuration Information 

In addition to auditing objects in the database, you can configure the console to audit 
changes that occur in the following HP OpenView Configuration workspaces: 

• Actions & Rules 

• Data 

• Presentation 
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• System Settings 

• Templates 

• Users & Security 

You can also configure the console to audit object deletions and history line deletions. 

This enhanced audit information is stored in the HP OpenView database. Here is an 
example of a list of audit entries: 

 

 

To manage the amount of audit data in the database, you can archive audit entries that 
have reached a certain age. 

 

NOTE: To view the enhanced audit log or modify the configuration audit settings, you 
must log on to the console by using an account that includes the Auditor role. 
The built-in System Administrator account does not include the Auditor role. 

 
View the Enhanced Audit Log 

You can view a list of all the configuration audit entries that have accrued since the last 
audit archive operation was performed. Current audit entries are stored in the HP 
OpenView database. 

To view the enhanced audit log: 

1 Log on to the console by using an account that includes the Auditor role and has 
permission to view the enhanced audit log. 

2 In the HP OpenView Configuration workspace group, click Users & Security. 

3 Expand the Audit branch. 

4 Expand Enhanced Auditing. 

5 Click Audit Log. 
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The enhanced audit log entries appear in the right pane. 

 

Modify the Configuration Audit Settings 

If you are a console auditor, you can instruct the console to create audit entries each 
time specific items in the HP OpenView Configuration workspace group change. You can 
also enable auditing for object deletions and history line deletions. 
 

NOTE: To modify the configuration audit settings, you must log on to the console by 
using an account that has the Auditor role. The built-in System Administrator 
account does not include the Auditor role. 

To modify the configuration audit settings: 

1 Log on to the console by using an account that includes the Auditor role and has 
permission to configure enhanced audit settings. 

2 In the HP OpenView Configuration workspace group, click System Settings. 

3 Double-click the Audit Configuration icon. 

4 In the Audit Configuration dialog box, click the Audit Configuration tab. 

5 If you want to audit changes that take place in any of the HP OpenView 
Configuration workspaces, follow these steps:  

a. Select Enable Enhanced Auditing. 

b. In the workspace tree on this tab, select all the things you want to 
audit: 

 

You can select whole branches of the tree or individual items within each 
branch. 

6 If you want the console to create an audit entry whenever an object is deleted from 
the database, select Audit Item Deletions. 
 
An audit entry will only be created if one or more attributes of this object type are 
already being audited. See the online help topic titled “Configure Audit Rules” for 
more information about auditing objects. 

7 If you want the console to create an audit entry whenever a history line is deleted, 
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select Audit History Line Deletions. 

8 Click OK. 

9 Log off the console. 

 

Archive Audit Information 

If you are a console auditor, you can initiate an archive process to move old audit entries 
to an archive file. This controls the size of the audit information in the database. You can 
specify the location of both the archive file and the log file for the archive process. You 
can also specify the age at which audit file entries should be archived. 

To archive audit information: 

NOTE: To modify the configuration audit settings, you must log on to the console by 
using an account that has the Auditor role. The built-in System Administrator 
account does not include the Auditor role. 

1 Log on to the console by using an account that includes the Auditor role and has 
permission to configure enhanced audit settings. 

2 In the HP OpenView Configuration workspace group, click System Settings. 

3 Double-click the Audit Configuration icon. 

4 In the Audit Configuration dialog box, click the Archive Configuration tab. 

5 In the Archive file box, type or browse to the folder (directory) where you want the 
console to store the archive of audit entries. 

6 In the Log file box, type or browse to the folder (directory) where you want the 
console to keep the log file for the archive process. 

7 In the Days box, enter the age in days after which an audit entry should be 
archived. 

8 Click Start to initiate the archive process. The progress bar indicates what fraction 
of the process is completed. 

9 When the archive process is finished, click View Archive to see the contents of the 
archive file; click View Log to see the details about the archive process. 

 

HP OpenView Performance Insight 

To use HP OpenView Performance Insight with Service Desk 5.10, you need to purchase the following 
components: 

• HP OpenView Performance Insight 5.1 

• HP OpenView Performance Insight Database Connector (one for each Service Desk server you want to 
report from) 

• Your choice of the following: 

⎯ HP OpenView Performance Insight Report Pack for Helpdesk Manager 

⎯ HP OpenView Performance Insight Report Pack for Change Manager 

⎯ HP OpenView Performance Insight Report Pack for Service Level Manager 

 49 



• Media and Manuals for HP OpenView Performance Insight are purchased separately.  The manuals are 
available in PDF format on the CDs. 

There is a starter bundle, HP OpenView Performance Insight Starter Bundle for Service Desk 5.10. This 
includes: HP OpenView Performance Insight 5.1, HP OpenView Performance Insight Database Connector, 
and the HP OpenView Performance Insight Report Pack for Helpdesk Manager. 

Prerequisites 
Database 

OVPI 5.1 supports only Oracle 9.2.0.5 with the “partitioning feature” configured. 

Note: Windows XP is not supported. 

Accessibility Support 
HP is working to ensure that new HP OpenView management software releases comply with the latest 
international accessibility standards.  HP OpenView Service Desk 5.10 accessibility includes an improved 
user interface interaction model that allows screen readers to support users with visual impairments, and 
enhanced keyboard navigation as an alternative to mouse control.   

Product characteristics based on accessibility standards include:  

• No animations in the user interface 

• No requirement for user speech 

• Operability within a limited reach and strength 

• No requirements for simultaneous actions except as provided by the operating system 

• Consistent meanings of images  

• No flashing at a frequency where photosensitive epilepsy is a risk 

• Redundant coding of all audio signals as provided by the operating system 

• No requirements for timed responses 

• Consistent and well-defined focus and selection indicators 

• Alternative text for images 

• Redundant coding for use of color 

• Online help optimized for screen readers 

HP OpenView Service Desk 5.10 supports accessibility on Microsoft Windows operating systems using JAWS 
for Windows 4.5.  For a more detailed report of product compliance with Section 508 of the American 
Rehabilitation Act, go to the Check Product Accessibility web page at http://vgwh3pro.cce.hp.com/508/.  
From the Select Product Category drop-down menu, select Software and Operating Systems, then click Go.  
On the next screen, select product family HP OpenView Service Desk, then click Go. 

Accessible electronic manuals for this product can be requested from the HP OpenView Product Manuals 
web site at http://ovweb.external.hp.com/lpe/doc_serv/ by clicking the Send Feedback link near the 
bottom of the page, and specifying the product name, product version, operating system, and document 
names that you would like to obtain in fully accessible form.   

To activate accessibility support for Service Desk: 

1 After product installation, look in the following directory  

%INSTALLDIR%\nonOV\jre\1.4\lib\ext  
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On Windows, the INSTALLDIR is the following: 

C:\Program Files\HP OpenView 

Make sure the Sun Java 2 platform edition 1.4.x files are located in the following directory: 

⎯ jaccess-1_4.jar 

⎯ access-bridge.jar 

If the files are not in the correct directory, copy them from the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\AccessBridge\installer\installerFiles. 

2 Add the AccessBridge directory to your path: 

PATH=%INSTALLDIR%\nonOV\jre\1.4\AccessBridge;%PATH%  

This step ensures that the DLLs are part of the Java Access Bridge, and can be found and instantiated. 

3 Make sure the accessibility.properties file is located in the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\lib directory.   

If needed, you can copy the file from the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\AccessBridge\installer\installerFiles 

The Java Virtual Machine (JVM) reads a number of property files as it starts up.   

4 Use each line in the accessibility properties file to enable different accessibility features.   

For example, to enable assistive technologies to use the Java Access Bridge, use a file editor to include 
the following line in the file: 

assistive_technologies=com.sun.java.accessibility.AccessBridge  

For additional properties examples and explanations (for example, how to set up screen magnifiers), 
refer to the Java Accessibility Utilities documentation: 

http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html

For more about configuring accessibility with Sun Java applications, refer to the following web site: 

http://java.sun.com/products/accessbridge/docs/setup.html.

Integration with Other HP OpenView Solutions 

For information about the integration with HP OpenView Operations, refer to the HP OpenView Service 
Desk OpenView Operations Integration Administrator’s Guide. For information about the other 
integrations, refer to the HP OpenView Service Desk Data Exchange Administrator’s Guide. These 
guides are released with the integration release of which they form a part; they are not delivered in Service 
Desk 5.10. 

 51 

http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html
http://java.sun.com/products/accessbridge/docs/setup.html


Troubleshooting 
This section describes how to troubleshoot some problems in Service Desk. 

Installation Fails 

Problem 

The installation fails. 

Workaround 

If youinstalled the management server, examine the log file, server_<build 
number>_HPOvInstaller.txt located in the %TEMP%\HPOvInstaller\ folder. 

The component log files are located in %TEMP%, in the HPOvInstaller directory. The paths and file 
names are as follows:  

Windows 

%TEMP%\HPOvInstaller\server_<build number>, where <build number> is the version and build 
number, such as 5.10.742 

package_msi_<component>_install.log, where <component> is the name of the component 

UNIX 

/var/tmp/HPOvInstaller/server_<build number>, where <build number> is the version and build 
number, such as 5.10.742 

package_depot_<component>_install.log, where <component> is the name of the component. 

These log files hold information about the native installation of the component. On a Windows platform, 
search in the log file for the word “Return Value 3”, which usually indicates there was an error. 

On HPUX, examine the swagent.log file located in /var/adm/sw/swagent.log.  

Examine the Object Server log file for information about why the installation failed. 

The Object Server log file is located in the following directory: 

%OVDATADIR%/log/system0.0_enUS 

This file contains the information from the Object Server and its tools. Look at the bottom of the file for any 
exception or other error message that might explain the failure. 

XPL Logging 

Problem 

You would like to change the way information is logged. 

Solution 

XPL logging uses the default Java logging.properties file. 

By default, this file is located in the following directory: 

C:\Program Files\HP OpenView\nonOV\jre\1.4\lib\logging.properties.  
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For this file to work, you must execute the following once:  

ovconfchg -ns xpl.log -set logparent true 

For example, if you want all the logs to be written to the console, add the following lines to your 
logging.properties file:  

handlers=java.util.logging.ConsoleHandler 

java.util.logging.ConsoleHandler.level=INFO 

java.util.logging.ConsoleHandler.formatter=java.util.logging.SimpleFormatter 

In the logging.properties file, you can specify the logging level: 

• SEVERE 

• WARNING 

• INFO 

• CONFIG 

• FINE 

• FINER 

• FINEST 

Example: 

To specify finer logging for the Object Server, add the following to your logging.properties file: 

java.util.logging.ConsoleHandler.level=FINER 

com.hp.ov.obs.level=FINER 

Object Server Cache 

Problem 

The Object Server cache can cause problems.  

Solution 

If you encounter a problem when you start the Object Server using ovc –start, try to delete the Object 
Server cache files by deleting all of the files in the following folder:  

C:\Program Files\HP OpenView\data\datafiles\obs 

Control Service Pid Files 

Problem 

You are unable to start the control service. 

Solution 

Execute the following command: 

Windows: 

del C:\Program Files\HP OpenView\data\tmp\*.* 

UNIX: 

rm –f /var/opt/OV/tmp/* 
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Console Does Not Show Any Workspaces 

Problem 

Your console screen does not display any workspaces. 

Solution 

Clear your user settings by executing the following command: 

del C:\Documents and Settings\%USERNAME%\Application Data\HP OpenView\*.* /s /q 

Socket Time Out 

Problem 

In some cases, the default value for the Socket Time Out management server setting is too low. This 
problem has been noted on the Sun Solaris operating system. 

If the following message appears in the system0.0.en_US log file, it might indicate that this setting should 
be increased: 

com.hp.ov.obs;SEVERE;Error: Interrupted due to: Read timed out. 

Solution 

Increase the value of Socket Time Out. Set a value of 5000ms (1000ms is the default). 

For more information about how to change Socket Time Out, refer to the HP OpenView Service Desk 
Administrator’s Guide. 

Support 
Please visit the HP OpenView support web site at:  

http://www.hp.com/managementsoftware/support   

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by being able to: 

• Search for knowledge documents of interest  

• Submit and track progress on support cases  

• Submit enhancement requests online 

• Download software patches 

• Manage a support contract  

• Look up HP support contacts  

• Review information about available services  

• Enter discussions with other software customers  

• Research and register for software training  
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NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract.  

To find more information about support access levels, go to the following URL:  

http://www.hp.com/managementsoftware/access_level  

To register for an HP Passport ID, go to the following URL:  

http://www.managementsoftware.hp.com/passport-registration.html

Legal Notices 
© Copyright 2005, 2006 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.  

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on 
all HP 9000 computers are Open Group UNIX 95 branded products. 

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries. 

Microsoft® is a U.S. registered trademark of Microsoft Corporation. 

OpenView® is a registered U.S. trademark of Hewlett-Packard Company. 

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.  

Windows® is a U.S. registered trademark of Microsoft Corporation.  
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